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CHAPTER 1

Understanding Film Lists

At various stages of postproduction, you need to generate lists that 
can be used to prepare conformed cut previews, optical effects, audio 
tracks, and eventually the final cut. FilmScribe provides tools for 
creating frame-accurate lists that can be used to conform a work print, 
a film negative, audio tracks, or videotape transfers. 

This chapter provides an overview of the situations in which you can 
use cut lists and change lists. It also describes specific types of optional 
lists you can generate.

This chapter includes the following major sections:

• Film List Concepts

• Cut Lists Versus Change Lists

• Frame Reference Numbers

• Understanding Optional Lists

• Using Icons in Lists to Represent Edits
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Film List Concepts

The Cut List and Change List tools allow you to generate detailed 
information for conforming the work print, the negative, or the audio 
tracks of a film project in various contexts:

• For screening of dailies or selects, you can generate scene and pull 
lists that the lab or an assistant editor can use to prepare a work 
print.

• For screenings of a current cut, you can generate ink number lists 
that the assistant editor can use for conforming a work print and 
magnetic track.

• For developing the final sound tracks, you can generate lists that 
the sound department can use for editing and mixing the original 
audio source reels.

• For preparing optical effects, you can generate lists that the optical 
house can use for comparing versions and generating optical 
effects.

• To compare different versions of a sequence or to determine a 
project’s reels, you can generate lists containing information about 
multiple sequences that the assistant editor can use to combine 
reels or bring conformed work prints up-to-date.

• For the final cut, you can generate key numbers lists that the 
negative cutter can use for conforming the negative.

• At all stages, you can also use your Avid editing system to record a 
digital cut of the sequence or a digital cut of the audio tracks for 
use in screening or as an aid in conforming the cuts.

The following section describes the two main types of lists you can 
generate in FilmScribe.
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Cut Lists Versus Change Lists

Cut lists and change lists provide breakdowns of exactly which frames 
should be cut from the work print or original negative. Unlike video 
edit decision lists (EDLs), which must conform to the specifications and 
limitations of various edit controllers, film lists are read by assistant 
editors or negative cutters. Avid’s cut lists also include 
industry-standard optical list information.

Cut lists and change lists serve two basic purposes:

• A cut list can be generated the first time to conform a work print, 
negative, sound track, or optical effect to match the sequence.

• A change list is generated to simplify the process of updating 
conformed cuts to match and compare changes in versions of the 
sequence or sequences.

In FilmScribe, each cut list uses the existing frame reference numbers 
contained in the bins to represent edit details in a sequence. Change 
lists use the same reference numbers to compare two or more versions 
of a sequence or a set of sequences in order to show only the changes 
necessary to bring previously conformed cuts up-to-date, which is 
useful for comparing versions of edited sequences.

When you are comparing a new sequence with a previous version of 
the same sequence, the change list indicates the following categories of 
sequence changes:

• Insertions for new material to be added

• Deletions of old material no longer needed

• Trims to be made to the heads, tails, or middles of the edits

• Moves that consist of a matched pair of deletions and insertions of 
an entire shot or shots

• Optional information that details which portions of the sequence 
should not be altered
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The following section describes the two main types of lists you can 
generate in FilmScribe.

Frame Reference Numbers

You can generate all the standard frame-reference information 
required for an assistant editor or negative cutter to conform a cut, 
provided that information has been entered in the bin.

n If you did not log a category of data during logging and digitizing, you can 
add optional information to the bin in your Avid editing system at any time 
before working with the list in FilmScribe. You can also add information 
using Avid MediaLog™. For example, if you add ink numbers in the Ink 
Number column after editing, the system will include these in the lists.

In addition, FilmScribe can display unique information not normally 
included in a conventional cut list. For example, you can include the 
following information in a list:

• Frame images. These are the thumbnail images of the initial 
frames of the clips in your sequence. They appear in the list only if 
you have:

- The Frame Images option selected in the Cut List Tool 
window

- QuickTime® software installed

.................................................................

..........................................................

.................................................................

................

................

Sequence 1A

Sequence 1B

Cut list

Conformed Cut 1A

Conformed Cut 1B

Conformed cut is
combined with
new material
through the
change list.

Clip Z

Clip ZClip YClip X

New Clip

Clip YNew ClipClip X

Change
list

..........................................................



12

- QuickTime files of your sequences

You can double-click the thumbnail image to open and play it in 
QuickTime.

For information about Cut List options, see “Understanding the 
Cut List and Change List Tools” on page 35. For information about 
QuickTime movies, see “Viewing Sequences as QuickTime 
Movies” on page 52 and “Preparing QuickTime Movies” on 
page 83.

• Comments. These are any added comments you associated with a 
clip in the sequence during editing. They appear in the assemble 
and optical lists only.

• Locator comments. These are any comments you associated with a 
particular clip using locators. They appear in the assemble and 
optical lists only.

Comments and locators can be very useful. For example, you can use 
locators to mark where the music begins, or you can provide specific 
color-correction instructions for a frame or clip and print these notes as 
part of your list. 

Understanding Optional Lists

Both cut lists and change lists include the use of optional lists that 
communicate specific tasks to the assistant editor, the negative cutter, 
the sound department, or the optical house. For example, these lists 
can instruct the facility to:

• Pull or assemble cuts, scenes, or takes in a particular order

• Remove takes that are no longer needed

• Layer and composite optical effects

• Check for duplicate frames and jump cuts

• Print or flag the required duplicate negative
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The heart of a cut list or change list is the assemble list, which provides 
a breakdown of the sequence into all its required parts. These might 
include scenes and takes, optical effects, and duplicate frames, all of 
which you can compile in additional, supporting sublists. You can also 
generate pull lists, which literally display material to be pulled by the 
assistant editor.

The following sections describe each type of optional list.

Assemble Lists

The assemble list shows the order in which a sequence’s clips, optical 
effects, or standard dissolves and fades are assembled from start to 
finish in the edited sequence. The assemble list also flags duplicate 
frames. In addition, you can choose to display optional settings and 
information categories such as camera rolls, sound rolls, lab rolls, 
comments, or locators. The types of numbers used for tracking can be 
key numbers and ink numbers. These numbers are displayed as a 
user-selected footage or frame count.

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
.

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
...

...
.

Clip A

Clip B

Optical

Clip B
(Dupe)

Clip C

Assemble list

1. Clip A

2. Clip B

3. Clip C

4. Optical

5. Clip B – Dupe

Pull list

Optical list

Dupe list
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A-Roll Versus A/B-Roll Conforming

FilmScribe assemble lists can represent either of the two conforming 
methods: A-roll or A/B-roll. Before generating a cut list or change list 
containing an assemble list, you select one of these methods based on 
the following criteria:

• A-roll or single-strand. Used primarily for 35mm film editing, this 
method requires the compositing of all multilayer effects into a 
single layer (including laboratory-standard dissolves and fades) 
before assembly. A-roll assemble lists contain information about 
all single-layer, straight-cut events. All other information about 
the sequence is described in the optical list.

• A/B-roll or double-strand. Used primarily for 16mm film editing, 
this method limits the amount of optical work by managing most 
standard dissolves and fades using two strands of film. A/B-roll 
assemble lists contain information about single-layer, straight-cut 

Part of an assemble list generated for A-roll (single-strand) conforming
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events as well as laboratory-standard dissolves and fades. All 
other information about the sequence is described in the optical 
list.

A laboratory-standard dissolve or fade is a multiple of 12 or 16 frames 
and is between 12 and 96 frames long. All other transition effects, 
titles, graphics, dissolves, and fades of nonstandard length will appear 
in the optical list.

n Sound lists are always displayed as A/B-roll and describe dissolves of any 
length.

Scene Assemble Lists

A variation on the standard assemble list is the scene assemble list, 
which presents the edit events sorted in the following order:

• Order of assembly

• Scene and take

• Reel number

.................................................................................... . . . . . . . . . . . . . . . . . . . . . . .

................................................................................... . . . . . . . . . . . . . . . . . . . . . . . .

.................................................................................... . . . . . . . . . . . . . . . . . . . . . . . .

..................................................................................... . . . . . . . . . . . . . . . . . . . . . . .

................................................................. . . . . . . . . . . . . . . . . . . . . . .....................

.................................................................................... . . . . . . . . . . . . . . . . . . . . . .

A-roll or single-strand

A/B-roll or double-strand
method

method

Optical – complete dissolve

A-side of dissolve

B-side of dissolve

Blended
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c The Scene/Take column must be filled in within the bin to generate 
a scene assemble list. 

n If you do not have scene information available before you work with the list in 
FilmScribe, you can enter the information quickly in your Avid editing 
system by copying the Name column in the bin and pasting that information 
into the Sc/Tk column. For information on copying text between columns, see 
the user’s guide to your Avid editing system.

Optical Lists

Optical lists specify the source material required to create special 
effects and any edit event other than a straight cut, such as a dissolve 
or fade that must be sent to an optical house for creation. The optical 
list presents each optical event in the order in which it appears in the 

Part of a sample scene assemble list
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sequence and includes specifications based on either ink numbers, 
Aux ink numbers, or key numbers.

Types of Effects Supported by Optical Lists

FilmScribe optical lists support the following effects and combinations 
of effects:

• All standard- and nonstandard-length transition effects, such as 
dissolves and fades

• Standard blend effects, such as superimpositions, title effects, 
matte key effects, luma keys, and chroma keys

Part of a sample optical list
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• Single-layer segment effect blowups, including moving blowups 
and resize flips and flops

• Other standard film effects such as flips, flops, flip-flops, and 
motion effects

• Combinations of single-layer effects, such as a flipped motion 
effect

• Tracking of keyframed previsualization markers 

• Clone and other paint effects

• Combinations of single-layer effects with blend effects, such as a 
key effect applied to a motion effect

• Transition and blend effects that appear on two separate picture 
tracks

• Overlapping transition effects on two separate picture tracks

n FilmScribe cut lists will not describe standard film masks that you apply to a 
clip or sequence to view a different aspect ratio. Standard masks are usually 
applied only after the conforming of a work print or negative. These masks are 
not effects and are used only to represent the cutoff of projected print in the 
theatre. Custom masks, which are effects, are described in the optical list.

Dupe Lists

Dupe lists refer to all the source material that the lab must duplicate 
before conforming the film negative. Additionally, dupe lists display 
unintended duplicate frames you might have edited into the sequence.

n To avoid including unnecessary dupes in your lists, use the Dupe Detection 
function during editing. Dupe handle lengths are set in the Timeline Settings 
dialog box in Avid editing systems. For more information, see the user’s guide 
to your Avid editing system. 
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The listed duplicate frames are organized within sets of dupe groups. 
Each dupe group set provides the IN and OUT points of two or more 
entries that are duplicates of each other in related sections of the 
sequence.

Dupes are also indicated in the assemble and pull lists by default, 
regardless of whether or not you choose to generate a separate dupe 
list.

Pull Lists

Pull lists display selected elements of the sequence in various sort 
orders. The pull lists show dupes but not comments or locators.

A sample dupe list
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Change Pull Lists and Change Discard Lists

When you are generating a change list, the Change List tool provides 
two additional options: the change pull list and the change discard list.

• The change pull list is similar to the pull list, except that it lists only 
new clips or effects that you need to insert into the updated cut.

• The change discard list displays each clip that has been removed 
from the updated sequence.

A sample pull list
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Scene Pull Lists

Scene pull lists show the cuts arranged in the following sort order:

• Scene and take

• Reel numbers

You can customize the sort order in the Options pane. For more 
information, see “Pull and Scene Assemble Lists” on page 75.

The scene pull list contains one entry for each scene and take that was 
referenced in the assemble list, as entered in the Sc/Tk column of the 
bins. Each entry displays the entire length of the take as defined by the 
clip from which it came. The Sc/Tk column must be filled in within 
the bin to generate a scene pull list.

A sample scene pull list
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Optical Scene Pull Lists

Optical scene pull lists show all the source material required to re-create 
the optical effects in the sequence. The optical scene pull list actually 
contains the same information as a scene pull list except that:

• Each optical is listed per scene.

• Takes required to re-create the optical are listed by scene number.

A sample optical scene pull list
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Using Icons in Lists to Represent Edits

Icons that graphically represent edit events can appear in your lists. To 
display the icons, select the Icons option in the Cut List or Change List 
tool. 

Cut List

Change List

Cut List icon

Change List icon
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Table 1-1 lists the icons available. 

The Bad Clip icon indicates clips that have discontinuity of edgecode. 
Discontinuities occur normally between scenes or takes in each KEM 
roll. When you create scene or take subclips from a digitized KEM roll 
master clip however, each subclip normally includes its own 
continuous edge code. If a subclip or edited portion of a KEM roll 
master clip accidentally includes a break in edge code between takes, 
then the Bad Clip icon appears in the lists.

c All list information following the Bad Clip icon is unreliable. If the 
Bad Clip icon appears in the lists, check all clips for the edge code 
information, adjust the errors, and generate new lists.

Table 1-1 Icons in Cut Lists and Change Lists

Cut List and Change List Change List Only

 Short Cut  Delete

 Jump Cut  Insert

 Fade Out  Insert Head

 Fade In  Insert Tail

 Dupe  Delete Tail

 Dissolve  Delete Head

 Optical  Delete Middle

 Optical Media

 Media Offline

Bad Clip icon
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CHAPTER 2

Working with FilmScribe

This chapter, which explains the main elements of and procedures for 
working with FilmScribe, includes the following sections:

• FilmScribe Workflow

• Starting and Quitting FilmScribe

• Understanding the FilmScribe Interface

• Working with Bins

• Working with the Cut List and Change List Tools

• Working in the List Window

• Viewing Sequences as QuickTime Movies

• Saving, Opening, and Printing Lists

• Working with Multiple Cuts and Reels

• Using the Matchback Option
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FilmScribe Workflow

When you use FilmScribe to prepare a list, your work generally 
involves the same basic flow. The basic workflow contains the 
following steps: 

1. Open the bin that contains the sequence with which you want to 
work.

2. Open the Cut List or Change List tool and bring the sequence into 
the tool from the bin.

3. Select options in the tool window to customize the list, or apply an 
existing group of option settings.

4. Generate the list and view it in the List window.

5. Save and print the list.

Under certain circumstances, you might also:

• Reopen a saved list 

• Work with more than one bin or sequence at the same time

• (Macintosh only) View the sequence in the Movie window

Starting and Quitting FilmScribe

You can start FilmScribe as a standalone application or you can start if 
from within your Avid editing system application.

(Windows) To start FilmScribe: 

1. Click the Start button on the taskbar.

2. Point to Programs.

3. Point to Avid.

4. Click Avid FilmScribe.
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(Macintosh) To start FilmScribe:

t Double-click the FilmScribe icon on the desktop.

To start FilmScribe from within your Avid editing system 
application:

t Choose FilmScribe from the Output menu.

FilmScribe opens as the active window.

(Windows) To quit FilmScribe, do one of the following:

t Choose Quit from the File menu.

t Click the Close button in the upper right corner of the main 
application window.

(Macintosh) To quit FilmScribe:

t Choose Quit from the File menu.

Understanding the FilmScribe Interface

The FilmScribe interface has the following main elements:

• Menu Bar

• Windows

• Help System

This section provides an overview of the functions performed by each 
of the following elements:

Menu Bar

The FilmScribe menu bar displays a series of menus that you can use 
to control the functions of the application.
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FilmScribe has two groups of menus — those that always appear and 
those that appear only when a specific window type is active.

Menus That Always Appear

Table 2-1 lists the general menus that always appear on the menu bar 
and describes the commands in each menu.

Menus That Appear for Specific Types of Windows

When you start FilmScribe, the menus listed in Table 2-1 are the only 
menus that appear. However, once you open a window, a new menu 
appears to the left of the Windows menu. The menu that appears is 
specific to the type of window that is active. For more information on 
window types, see “Window Types” on page 29.

Table 2-1 General Menus

Menu Description

File Provides commands for opening and closing bins and 
tools, saving and printing lists, and quitting the 
application.

Edit Provides commands for undoing and redoing the most 
recent user action and for basic editing functions.

Font, Style,
Size, Color

Provides commands for changing the appearance of the 
text in a cut list or change list.

Windows Provides commands for positioning the status bar and 
for navigating the open windows.

Help Provides commands for accessing the Help system.
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Table 2-2 lists the window-specific menus and describes the 
commands in each menu.

Window Types

You work with sequences, list options, and lists in different windows 
within FilmScribe. Table 2-3 lists these window types and describes 
the tasks you can perform in each type.

Table 2-2 Window-Specific Menus

Menu Description

Sequence Appears when a bin is the active window and provides 
commands for opening sequences in the Cut List or 
Change List tool. You can also open the Sequence menu 
as a pop-up (contextual) menu within a bin by 
right-clicking (Windows) or Ctrl+clicking (Macintosh) a 
sequence.

CutList Appears when the Cut List tool is the active window 
and provides commands for clearing sequences in the 
tool and for generating and previewing a list.

ChangeList Appears when the Change List tool is the active 
window and provides commands for clearing 
sequences in the tool and for generating and 
previewing a list.

List Appears when the List window is the active window 
and provides commands for expanding and collapsing 
the list view.

Movie Appears when the Movie window is the active window 
and provides commands that control the way the movie 
plays and the size of the window.
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Table 2-3 Window Types

Window Type Description

Bin Open any bin from an Avid editing system, sort the 
sequences in the bin, and select sequences to move into 
the Cut List and Change List tools. For more 
information on bins, see “Working with Bins” on 
page 31.

Cut List Tool and 
Change List Tool

Prepare and generate cut lists in the Cut List Tool 
window and change lists in the Change List Tool 
window. Choose which kinds of lists to generate, which 
sequences to generate from, and which tracks to include 
in your lists. Set options that define what kind of 
information goes into your lists. You can also work with 
option settings in the tool windows. For more 
information on the Cut List and Change List tools, see 
“Working with the Cut List and Change List Tools” on 
page 34. For more information on settings, see “Using 
Settings to Save, Recall, and Remove Options” on 
page 44.

List Preview the lists that you have generated or open 
previously saved lists. For more information on the List 
window, see “Working in the List Window” on page 47.

Movie View QuickTime movie versions of the sequences
with which you work. This feature is available only 
when QuickTime is installed and you have created a 
QuickTime movie version of your sequence. For more 
information, see “Viewing Sequences as QuickTime 
Movies” on page 52.
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Using Help

The Help provides all the information contained in Avid FilmScribe 
User’s Guide, and operates in a Web browser. To open the Help, choose 
Avid FilmScribe Help from the Help menu in the Avid FilmScribe 
application. For information about using the Help, click the Using 
Help button in the Help system.

Working with Bins

Bins are the specialized files used by Avid editing systems to organize 
clips and sequences. The first stage in generating lists with FilmScribe 
is to open one or more bins that contain the sequences with which you 
want to work.

FilmScribe can open bins that were created on Macintosh-based or 
Windows-based Avid editing systems. When you open a bin, 
FilmScribe displays all the sequences in that bin but does not display 
other kinds of files (such as clips and subclips) that might be in the bin.

Opening and Closing Bins

To open a bin:

1. Choose Open from the File menu.

A dialog box appears.

2. Navigate to the folder that contains the bin you want to open.

3. Click the bin you want.

4. Click Open.

The bin opens.
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(Windows) To close a bin:

t Make the bin the active window, and then do one of the following:

• Choose Close from the File menu.

• Click the Close button in the upper right corner of the bin.

(Macintosh) To close a bin: 

t Make the bin the active window, and then choose Close from the 
File menu.

Understanding the Bin Window

Sort direction buttonBin status bar

Sequence display area

Column heading buttons
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A bin window has the following features:

• The status bar displays information about the project with which 
the bin is associated:

- The format of the project (NTSC or PAL, Film or Video)

- The frames-per-second (fps) rate of the project (24, 25, or 30)

- The matchback status of the project (either Matchback or 
Non-Matchback)

• The column heading buttons display the names of selected 
headings associated with that bin. For more information on bin 
headings, see the user’s guide to your Avid editing system. 

• The sort direction button controls the order in which sequences in 
the bin are sorted.

• The main display area shows a row of information for each 
sequence in the bin. Scroll vertically if you need to view all the 
sequences.

Sorting Items in Bins

You can sort the sequences in a bin by any of the column heading 
categories. For example, you might want to sort by reel number so that 
all the sequences from one reel are grouped together. FilmScribe sorts 
the sequences in alphabetical or numerical order, whichever is 
appropriate to the heading.

To sort items in a bin:

t Click the column heading button for the category by which you 
want to sort.
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Ascending sort

To switch between ascending (A to Z) and descending (Z to A) sort:

t Click the sort direction button, located to the right of the column 
heading buttons.

Descending sort

The arrow on the button points up when ascending sort is selected 
and points down when descending sort is selected.

Working with the Cut List and Change List Tools

The Cut List and Change List tools allow you to set options for the lists 
you want to generate.

Opening and Closing the Tools

To open the Cut List or Change List tool, do one of the following:

t Choose New Cut List or New Change List from the File menu.

t Select a sequence in a bin, and then choose the appropriate item 
from the Sequence menu. For more information, see “Using the 
Sequence Menu” on page 39.

To close the Cut List or Change List tool, do one of the following:

t Make the tool the active window, and then choose Close from the 
File menu.

t Click the window’s Close button (Windows) or close box 
(Macintosh).
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Understanding the Cut List and Change List Tools

In the Windows 2000 operating system, the FilmScribe check boxes now have 
a slightly rounded look. Their functionality, however, remains the same as in 
previous Windows versions.

Options paneSequences paneTracks pane
and buttons

Title text box
Settings pop-up menu Preview button

Cut List Tool Features

Lists pane

n
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The Cut List tool has the following features:

• The Sequences pane displays currently loaded sequences.

• The Lists pane allows you to choose specific types of lists in 
addition to the main assemble list.

• The Tracks pane allows you to select the tracks to be included in 
the list: video (picture) or audio tracks.

• The Title text box allows you to type a name for the list.

• The Settings pop-up menu allows you to save your current cut list 
settings and selections for future use.

• The Preview button generates the list and opens the List window 
for previewing the list.

• The Options pane provides controls for customizing each of the 
lists you choose to generate.
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The Change List tool has many of the same features as the Cut List 
tool, with the following differences:

• The Change List tool has two sequences panes: one for the old 
versions of the sequences and one for the new versions.

• Because old and new sequences lists exist, the Change List tool has 
two list panes. The panes allow you to select assemble or dupe 
lists separately for each sequence to include in the comparison 
when generating the list.

Change List Tool Features

New Lists pane

Old Lists paneOld Sequences pane

New Sequences pane

Change Lists pane
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• The Change Lists pane allows you to choose the specific types of 
change lists you want to generate.

Getting Sequences

The two ways to get sequences into the Cut List or Change List tool are 
described in the following sections:

• Dragging Sequences from Bins

• Using the Sequence Menu

Dragging Sequences from Bins

To get a sequence by dragging:

t Drag the sequence you want from the bin to the Sequences pane in 
the Cut List tool, or to the Old Sequences or New Sequences pane 
in the Change List tool.

The name of the loaded sequence appears in the pane.

n To select more than one sequence, Ctrl+click (Windows) or Shift+click 
(Macintosh) each sequence you want, and then drag the sequences to the tool.
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To add a sequence to a Sequences pane that already contains 
sequences:

t Press and hold the Alt key (Windows) or Option key (Macintosh) 
while you drag the additional sequence into the pane.

The name of the additional sequence is added to the pane.

c If you do not press and hold the Alt key (Windows) or Option key 
(Macintosh) while dragging additional sequences into a pane, 
FilmScribe replaces the contents of the pane with the new selection.

Using the Sequence Menu

When you use the Sequence menu commands to get sequences, you 
do not need to have the Cut List or Change List tool open. FilmScribe 
opens the tool if it is not already open. 

To get sequences using the Sequence menu:

1. Make the bin the active window.

2. Click the sequence you want.

3. Choose the appropriate command from the Sequence menu:

• Open in Cut List Sequences

• Open in Change List Old Sequences

• Open in Change List New Sequences

The Cut List or Change List tool opens (if it is not already open), 
and the name of the sequence appears in the appropriate 
Sequences pane.

n You can also open the Sequence menu as a pop-up menu in a bin. To do this, 
click the sequence using the right mouse button (Windows) or Ctrl+click the 
sequence (Macintosh). 
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To add a sequence to a list that already contains one or more 
sequences:

1. Make the bin the active window.

2. Click the sequence you want.

3. Choose the appropriate command from the Sequence menu:

• Append to Cut List Sequences

• Append to Change List Old Sequences

• Append to Change List New Sequences

The Cut List or Change List tool opens (if it is not already open), 
and the name of the additional sequence is added to the 
appropriate Sequences pane.

When you load the first sequence, FilmScribe determines whether the 
sequence was previously used to generate cut lists. If so, the settings 
that were last used are automatically displayed.

Clearing Sequences

To clear sequences from the Sequences panes in the Cut List or 
Change List tool:

1. Make sure that the tool from which you want to clear sequences is 
the active window.

2. Choose Clear Sequences from the CutList or ChangeList menu.

FilmScribe removes the names of sequences in the panes.

n Closing the Cut List or Change List tool also clears sequences from the 
Sequences panes. (Most other settings will be saved when you close the tool. 
For more information, see “Using Settings to Save, Recall, and Remove 
Options” on page 44.)
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Selecting Tracks

The Tracks pane displays a button for each track that exists in the 
sequence. FilmScribe generates lists only for the tracks you select.

To select or deselect tracks, do one of the following:

t Click a track button to select or deselect it.

t Choose Select All Tracks or Deselect All Tracks from the CutList or 
ChangeList menu.

If the sequence is a 30-fps sequence (that is, a matchback project), 
audio tracks are not shown because matchback applies to picture-only 
sequences. Generate a separate edit decision list (EDL) for sound. For 
more information, see the documentation for your Avid editing 
system and for Avid EDL Manager.

n If you select the Separate List for Each Channel option, you can select any 
combination of picture tracks. For more information, see “Using the Options 
Pane” on page 42. The Separate List for Each Channel option has no effect on 
audio tracks; you can always select any combination of sound channels.

Renaming the List

FilmScribe takes the name of your first loaded sequence and applies 
that name to your list by entering it in the Title text box. 

To give the list a different title name:

t Type it in the Title text box. Whatever title you type here will 
appear as the name of the list when you print or save it.



42

Using the Options Pane

The Options panes contain specific options that apply to different 
types of lists. The Cut List tool has five basic option displays:

• Global options affect the overall content of the list and its display 
options. 

• Assemble list options include standard film and timecode tracking 
numbers, transition indications, and custom information such as 
comments and locators.

• Optical list options include film and timecode tracking numbers, 
custom column information, keyframe, optical footage, and page 
break information.

• Dupe list options include film and timecode tracking numbers, 
custom column information, tolerance, and handle length 
information. Dupe handles can be adjusted by the user and 
default to one frame.

• Pull list options include film and timecode tracking numbers, 
custom column information, pop-up menus for three levels of 
sorting, specifications for spooling method, and inclusion of 
opticals and film leader. The same options are available for optical 
pull lists, scene assemble lists, scene pull lists, and optical scene 
pull lists.

The Change List tool has one additional basic option display:

• Change list options include specifications for listing only changes, 
for combining deletions, and for assigning preview code. You can 
also set the counter start number for the viewing footage.

n For a complete description of all the options, see Chapter 3.
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To select options:

1. Click a list type in the Lists pane.

The list type is highlighted in the Lists pane, and the options for 
that list type appear in the Options pane (the right half of the tool). 
A check mark indicates which lists will be created.

2. Select check boxes, choose from pop-up menus, or type in text 
boxes to select the options you want.
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Copying Options Between List Types

After selecting assemble list options, you can instantly apply the same 
options to other list types.

To copy options to another list type:

1. Select the assemble list options you want.

2. Click another list type in the Lists pane.

3. Click the Same As Assemble List button (in the Change List tool, 
click the Same As Change List button) at the top of the Options 
pane.

Changing the Options

You can change the cut list or change list options any time before or 
after generating a list.

To adjust the options and update the list:

1. Alter your selections in the Options pane.

2. Regenerate the list.

Using Settings to Save, Recall, and Remove Options

The Settings feature allows you to save a set of options under a specific 
name. You can then quickly recall those options when you need to 
apply them again. The Settings feature remembers which list types 
you have chosen to generate, as well as all the options you have 
selected in the Options pane. The Settings feature does not remember 
which sequences you have loaded, or the title or track selection.
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To recall a previous setting:

t Click the Settings pop-up menu and choose a setting.

To save the current options as a setting:

1. Click the Settings pop-up menu, and choose Save As.

A dialog box appears.

2. Type a name for the setting, and then click OK.

If you start to accumulate too many settings in your list, you can 
remove settings you no longer use.

Settings pop-up menu
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To remove settings:

1. Click the Settings pop-up menu, and choose Remove Settings.

The Remove Settings dialog box appears. 

2. Choose the setting you want to remove and then click Remove.

n The setting that is currently open does not appear in the Remove Settings 
dialog box.

3. Do one of the following:

t Click Done to remove the settings permanently and close the 
Remove Settings dialog box.

t Click Cancel to restore any settings you have removed and 
close the Remove Settings dialog box.
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Previewing the List

After selecting options for your lists, you are ready to generate the lists 
and preview them in the List window. 

To generate the lists and open the List window:

1. Choose the list types you want to generate by selecting the 
appropriate check boxes in the Lists pane. 

2. Click the Preview button at the bottom of the Cut List or Change 
List tool.

The List window opens, displaying the lists.

Working in the List Window

When you generate a list, it appears in a List window. You can use this 
window to view your list and to change its appearance. When you 
open a saved list, it also appears in a List window. 

Check
boxes
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Opening a List Window

To open a List window, use either of the following methods:

t Click the Preview button in the Cut List or Change List tool.

t Open a previously saved list. See “Saving, Opening, and Printing 
Lists” on page 55.

Before you save a list, the title bar of the List window reads “Cut List 
Preview” or “Change List Preview.” After you save a list, and when 
you open a saved list, the title bar shows the name of the saved list.

You can use the standard Windows or Macintosh controls to scroll 
through the list within the window or to resize the window so that you 
can see more of the list.

List window status bar
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Understanding the List Window Status Bar

Table 2-4 describes the icons and messages that can appear in the List 
window status bar:

Table 2-4 List Window Status Bar Messages

Message Description

Appears on the left side of the status bar:

 List is current Indicates that the list matches the current option 
settings in the Cut List or Change List tool.

 List is NOT current If you generate a list and then return to the tool 
to change options, this message appears. It 
indicates that the list no longer matches the 
current option settings in the Cut List or Change 
List tool.

Regenerate the list to make it current again.

Appears on the right side of the status bar:

Modified Indicates that you have modified the list in the 
window since it was last saved. This message 
also appears for a newly generated list that you 
have not yet saved.

Saved Indicates that the list in the window exactly 
matches the saved list.
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Expanding and Collapsing Lists

Generated lists appear in the List window with heading bars. These 
bars indicate the list type and enable you to collapse or expand each 
list. You can also expand or collapse all lists at once, switching from a 
view that shows all your lists in full to one that shows only the 
heading bars.

(Macintosh only) To expand or collapse a list:

t Click anywhere in the heading bar.

To expand or collapse all lists:

t Choose Expand Lists or Collapse Lists from the List menu.

Using the List Summary Option
When there are multiple 
tracks, clicking the List 
button brings you to the 
beginning of the group 
of assemble lists, not to 
the list you selected. 
This is also true for 
other lists, such as 
optical lists.

If you select List Summary in the Global Options pane, a list summary 
appears above all the other lists. This summary has its own heading 
bar and also displays a navigation button to the left of each list 
summarized.

To move to the top of a particular list:

t Click the button for that list in the list summary.
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Editing and Formatting Lists

The List window functions as a basic text editor. You can edit and 
format your lists in a variety of ways to customize them for your 
particular needs. You can add comments; cut, copy, and paste material; 
or use typographical distinctions (font type or style, text size or color) 
to highlight parts of the list.

This feature enables you to alert the readers of your lists to special 
issues and concerns. You can also easily create slightly different 
versions of the same list, for different audiences, by commenting and 
highlighting the list in different ways and then printing individual 
copies. 

c All the text that displays in the List window can be edited. Typically, 
you will not want to change the generated information that is in the 
list. Take care not to delete important material.

To add a comment to your list:

t Move the cursor to the place where you want the comment, and 
type your comment.

n You might want to use a different text color for any comments that you add in 
the List window. (Choose a color from the Color menu, and then type your 
comments.) You can then easily distinguish them from comments made 
earlier in the editing process.

For information on 
editing commands, see 
your Windows or 
Macintosh 
documentation.

To edit material in the list:

t Select the material you want to edit, and choose the appropriate 
command from the Edit menu.

To highlight text using typographical distinctions:

1. Select the text you want to highlight.

2. Choose the typographical effect you want from the Font, Style, 
Size, or Color menu.
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n If you are able to print your lists in color, or if they will be viewed onscreen by 
their intended readers, color is probably the most effective way to highlight 
your lists. You can highlight all comments in red, for example. Or you can 
provide comments in different colors, keying each color to the needs of a 
particular reader of the list.

Changing the Appearance of Text in Generated Lists

After generating a list, you can modify its appearance by changing the 
font and the font’s style, size, and color. These changes will affect the 
whole list.

To alter your list’s appearance:

t Choose the appropriate item from the Font, Style, Size, or Color 
menu.

Viewing Sequences as QuickTime Movies

If the sequence with which you are working is available to FilmScribe 
as a QuickTime movie, and you select the Frame Images option in the 
Global Options area of the Cut List Tool or Change List Tool windows, 
the list that you generate includes a thumbnail image of the head 
frame for each event in the list.

The image thumbnails provide an immediate visual reminder of the 
sequence. You can also use these thumbnails to open the QuickTime 
movie of the sequence in the Movie window. You can then play all or 
part of the sequence.
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To use this feature, first export your sequences from your Avid editing 
system as QuickTime movies (.mov) files, and make those files 
available for FilmScribe to read them. You must have QuickTime 
loaded on your computer. For information on preparing QuickTime 
movies of sequences and making them available to FilmScribe, see 
“Preparing QuickTime Movies” on page 83. 

Opening Movie Sequences

To open a sequence in the Movie window:

t Click the image thumbnail.

The Movie window opens, displaying the frame of the movie 
sequence represented by the thumbnail.

You can also open a movie directly into the Movie window by 
choosing Open from the File menu and then opening the movie file.

n List files generated by FilmScribe are not compatible across platforms. You 
cannot open a list created in FilmScribe for Macintosh by using FilmScribe 
for Windows, or vice versa. 

Controlling the Play of Movie Sequences

You can control how a movie sequence plays in the Movie window by 
using controls on the window itself and using commands in the Movie 
menu. You can also use commands in the Movie menu to alter the size 
of the Movie window.
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Table 2-5 describes the controls in the Movie window. Table 2-6 
describes the commands in the Movie menu.

Table 2-6 describes the commands in the Movie menu that control 
movie play or the size of the Movie window.

Table 2-5 Movie Window Controls

Control Description

Play/Pause button Click to play a movie. When a movie is playing, the 
Pause button is displayed. Click the Pause button 
to stop play.

Slider The horizontal bar is a graphical representation of 
the length of the movie. The slider marks the point 
in the movie that is currently displayed. Click on 
the bar to move to any specific point in the movie. 
Drag the slider along the bar to fast forward or 
rewind through the movie.

Step Backward button Click to step backward one frame.

Step Forward button Click to step forward one frame.

Table 2-6 Movie Menu Commands

Command Description

Loop Plays the movie repeatedly. When the system 
reaches the end of the movie, it returns to the 
beginning and starts play again.

Loop Back and Forth Plays the movie repeatedly, in alternating 
directions. When the system reaches the end of the 
movie, it starts to play the movie backward from 
the end point.
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Saving, Opening, and Printing Lists

When the list is ready, you can print it immediately or save it as a text 
file that you can bring to another location, import and use in another 
system, or open and print at a later time. 

After the list is saved, you can edit it in a text editor. For example, you 
can add comments for an assistant editor or a negative cutter.

n List files generated by FilmScribe are not compatible across platforms. You 
cannot open a list created in FilmScribe for Macintosh by using FilmScribe 
for Windows, or vice versa.

Play Selection Only Plays only a selection of the frames in the movie. 
Playback jumps from one selected frame to the 
next.

Play All Frames Plays every frame in the movie.

Half Size Decreases the size of the Movie window by half, 
which can increase the movie playback speed.

Normal Size Returns the Movie window to its default size.

Double Size Doubles the size of the Movie window. Increasing 
the window size allows you to see images more 
clearly but can slow down movie playback.

Table 2-6 Movie Menu Commands (Continued)

Command Description
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Saving Lists

To save a list:

1. Choose Save from the File menu.

The Save Options dialog box appears.

2. Choose the desired option, and then click OK.

A dialog box appears.

3. Type the file name in the File name text box.

4. Choose a destination for the file.

5. Click Save.

n (Windows only) Avid recommends that you use the .txt file name extension at 
the end of all list names. FilmScribe works best with saved lists that have this 
file name extension.

Opening a Saved List

To open a previously saved list in a List window:

1. Choose Open from the File menu.

A dialog box appears.

2. Navigate to the location of the file you want to open.

3. Click the file name, and then click Open.
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Printing Lists

To print a list:

1. Choose Print from the File menu.

The standard Print dialog box appears.

2. Choose the Print options you want, and then click OK (Windows) 
or Print (Macintosh).

FilmScribe prints the list exactly as it appears in the List window. 

Working with Multiple Cuts and Reels

In the advanced stages of a project, you might need to make cut lists or 
change lists for conforming work prints or making comparisons 
between multiple cuts or reels. FilmScribe provides specific features 
that allow you to:

• Create a single cut list for several sequences so you can compile 
them for a single conformed cut

• Create change lists for multiple screening reels so you can update 
the conformed reels, make comparisons between sequences, or 
adjust breaks between reels in preparation for a final cut

Creating a Cut List for Two or More Sequences

With two or more sequences loaded, the system generates one cut list 
with appended sections for all sequences in their listed order. The cut 
list provides lists for the sequences in order.
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To create a single cut list for several sequences:

1. Make sure the sequences are named so that they are sorted in the 
proper order in the Cut List tool.

2. Ctrl+click (Windows) or Shift+click (Macintosh) the chosen 
sequences in the bin, and drag them to the Sequences pane.

3. Choose the options you want, and generate the list.

The cut list provides lists for the sequences in order.

Creating Change Lists Across Multiple Reels

When you load comparable sequences, FilmScribe generates 
consecutive, appended lists for each set of cuts. You can make 
comparisons based either on reel numbers or on preview code that 
you assign to each sequence.

Depending on the options you select, the new list notes any of the 
standard change categories across the reels:

• Insertions of new material

• Deletions of material no longer needed

• Trims to be made to the heads and tails of the edits

• Moves that consist of a matched pair of deletions and insertions

• Optional information that details which portions of the sequence 
should not be altered

In addition, you can generate separate lists for each set of reels and 
simultaneously generate a single dupe list that describes duplicated 
shots across all the reels. These topics are described in this section.
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Using Reel Numbers

When you use reel numbers to generate change lists for multiple reels, 
observe the following conditions:

• For each sequence, the old version and the new version must have 
exactly the same reel number in order for the system to make the 
appropriate comparisons.

• The reel numbers must be entered into the Reel # column in the 
bin for each sequence.

• The reel numbers must be consecutive so that the system can 
generate lists that match the appropriate order of the reels; for 
example, sequence 1.1, sequence 1.2, and so on.

• You must have an equal number of old and new sequences. If 
necessary, create a dummy sequence to balance the reels.

To generate a change list using reel numbers:

1. Prepare the sequences with the appropriate reel numbering if 
necessary.

2. Ctrl+click (Windows) or Shift+click (Macintosh) all the old 
sequences in the project bin (each sequence must represent a 
different reel).

3. Drag the selected sequences into the Old Sequences pane to load 
them. 

4. Repeat steps 2 and 3 for the new sequences, dragging them into 
the New Sequences pane. Each new sequence must represent a 
different reel that shares the same reel ID as the corresponding old 
sequence.

5. Add sequences to the lists as necessary by pressing and holding 
the Alt key (Windows) or Option key (Macintosh) while dragging 
the selections into the appropriate Sequences pane.

6. Select the options you want and generate the list.
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Using Preview Code

Preview code is an optional numbering system that you can use to ink 
each conformed work print with continuous numbers that you match 
for the corresponding sequence in FilmScribe.

Preview code applies to one generation of changes on the work print 
only. You must re-ink each successive work print and enter those 
preview code numbers as KN Start numbers for each new revision of a 
sequence. 

n You can request that the lab differentiate successive generations of preview 
code by applying different colors.

Preview code both supplants comparisons based on reel numbers and 
provides the advantage of continuous numbering within each 
generation of a sequence or cut.

c Because new material edited into the sequence has not yet been 
inked with preview code, you must choose the options for 
displaying key numbers or ink numbers for referencing the original 
source footage for these clips in the list.

To track changes with preview code in the Avid editing system (or in 
Avid MediaLog) and in FilmScribe:

1. After re-inking the first work print with preview code, enter the 
matching start preview code number in the KN Start column of 
the bin for the corresponding sequence.
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c Change the starting key number for the sequence only. Do not 
override KN Start information for the original master clips used in 
the sequence.

2. Duplicate the sequence, and place the original into an archive bin.

3. Rename the duplicate, but be sure to maintain the same reel 
number in the Reel # column of the bin.

4. Continue editing the duplicate sequence.

5. When the time comes to generate a new change list in FilmScribe, 
load the old and new sequences, and select Preview Code from the 
Change List options.

6. After the work print is reconformed, ink the new work print with 
new preview code, and enter matching numbers in the KN Start 
column for the corresponding sequence (the duplicate of the 
original sequence).

7. Duplicate this sequence, and continue the same cycle as often as 
necessary.

Dupe Checking Across Multiple Reels

If your project consists of multiple reels, it probably has a separate 
sequence for each reel. These reels, however, might share footage that 
requires duplication. FilmScribe allows you to check for dupes across 
multiple reels within one change list.

Enter the new preview code numbers in the KN Start column.
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To generate a dupe list for multiple reels:

1. Follow the steps described in “Using Reel Numbers” on page 59 
for loading comparable reels into the Change List tool.

2. When choosing options for the list, select Assemble list, Dupe list, 
and Reel Numbers options.

Using the Matchback Option

The matchback option that is available on some Avid editing systems 
allows you to generate a film cut list from a 30-fps video project that 
uses film as the source material. This video-to-film conversion is 
useful in a variety of matchback circumstances, including the 
following:

• To generate a videotape master for the project along with a final 
cut on film

• To generate pull lists for retransferring selects at high quality 
before online editing

n Editors working on a film matchback project for the first time should pay 
extra attention to duplicate material in the final edited piece. Use Dupe 
Detection in the Timeline and verify any dupes flagged.

Understanding Matchback

The matchback process refers to the video edit information for your 
sequence and performs a conversion to create a matching 24-fps cut 
list.

Because of the difference in frame rates between video and film (30 fps 
or 25 fps for video versus 24 fps for film), the conversion of video edit 
points might fall within a film frame, requiring the addition or 
subtraction of a frame in that edit event in the resulting cut list. 
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For example, with a ratio of 24 film frames to 30 video frames, a 
seven-frame video edit corresponds to approximately 5.6 film frames. 
However, film cuts cannot include partial frames, so the edit must be 
rounded to five or six frames.

The following adjustments occur during matchback:

• If the total video-sequence duration at the end of each cut is a 
frame longer than the film, then the system subtracts a frame from 
the last video edit. If the video is a frame too short, a frame is 
added to the last video edit. 

• Where an essential frame was added or subtracted to the 
beginning or end of each edit, the system adds matchback 
information to the cut list stating that matchback shortened or 
lengthened the tail of the clip by one frame. The assistant editor or 
negative cutter can use this information to check the edit.

• Each track in the sequence must be corrected independently 
because the start and end points for split edits are different for 
each track. As a result, the picture and audio for a matchback 
video edit might be out of sync by no more than one frame.

Matchback is subject to the following limitations:

• The matchback option uses key numbers to conform the negative. 
Therefore, you must have key number information entered in the 
bins for the project.

• You can generate cut lists but not change lists in a matchback 
project.

..........................................................................................................

Clip X Clip Y Clip Z
NTSC
video

Film

The matching film edit point falls within a
frame.

..........................................................................................................
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• The matchback information applies to the picture only. You must 
generate a separate list (an EDL, for instance) for conforming the 
audio source tapes.

• Be sure to remove unwanted match frames (add edits) from your 
sequence before generating the cut list. Otherwise, the calculation 
of matchback frames will include these edits. For more 
information, see Appendix A.

Generating a Cut List with Matchback

To generate a cut list with matchback, you must first set up matchback 
options at the project level in your Avid editing system. For more 
information about setting up matchback options while starting a 
project, see the user’s guide to your Avid editing system.

To generate a cut list with matchback information:

1. Create a sequence.

2. Use the procedures for getting a sequence, selecting tracks, and 
choosing settings, as described in “Working with the Cut List and 
Change List Tools” on page 34.

3. When you choose Global options, select the Matchback Info 
option in the Options pane to display the matchback information 
in the list.
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CHAPTER 3

Film List Options

This chapter explains all the options you can use to customize your cut 
and change lists. It includes the following main sections:

• Cut List Global Options

• Cut List Options That Are Common to All Lists

• Cut List Options That Are List Specific

• Change List Global Options

• Change List Options That Are Common to All Lists

• Change List Options That Are List Specific

Cut List Global Options

Global options affect the appearance and format of all the generated 
lists. Table 3-1 describes the global options.
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Table 3-1 Cut List Global Options

Option Suboption Description

Template TAnimation Displays a list that is customized for animators, 
including a running counter, frames, durations, and 
the clip name.

TColumnar Displays columns of selected information in the 
simplest information-display format.

TLogExchange (ALE) The standard log format for Avid systems; used 
mainly to translate cut lists into the ALE format 
(which is used for standard file exchanges across 
non-Avid products).

TOpticalBlock Lists all opticals graphically (instead of textually).

OpticalBlock cannot be used as a template for 
matchback lists.

TStoryboard Displays a list that is customized for animators, 
including the clip name, scene, and take.

TTabDelimited Allows you to export the cut list or change list, and 
then open it in another application, such as database 
programs, for example, FileMaker® Pro.

Picture
Conforming

Selects the conforming method that is used to 
conform the picture. This option has no effect on 
sound lists. This affects how standard-length 
dissolves and fades are treated.

This option is not present for change lists, which 
always assume A-roll conforming.

A Roll (Single Strand) All transition effects, regardless of type or length, are 
treated as opticals.
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A/B Roll (Double Strand) Standard-length dissolves, fade-ins, and fade-outs 
are placed directly in the assemble list and are not 
treated as opticals unless they are part of some other 
optical effect such as a motion effect. The standard 
lengths are 16, 24, 32, 48, 64, and 96 (frames).

Using Key Number (KN Start)
Ink Number
Auxiliary Ink
Film TC

Choose the type of numbers to use to conform the 
picture. FilmScribe uses this value to ensure that 
those numbers exist for all sources. If a source lacks 
the required numbers, the Cut List tool displays a 
message box.

Sound 
Conforming 
A/B Roll 
(Double Strand)
Using

Ink Number

Auxiliary Ink

Choose the type of numbers to use to conform the 
sound tracks. FilmScribe uses this value to ensure 
that those numbers exist for all sources. If a source 
lacks the required numbers, the Cut List tool might 
display a messagebox.

Running Footage as Total Frame Count
16mm – 20 fr 
16mm – 40 fr
35mm – 2 perf
35mm – 3 perf
35mm – 4 perf
35mm – 8 perf
65mm – 5 perf
65mm – 8 perf
65mm – 10 perf
65mm – 15 perf

Specifies the format in which to make the 
incrementing count for the sequence.

Durations as Frames 

Footage

Displays the duration in the specified number of 
frames.

Displays the duration in the format selected under 
Running Footage as.

Table 3-1 Cut List Global Options (Continued)

Option Suboption Description
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Monospace Font Choose font style options for the display and printing 
of cut lists and change lists.

In general, monospaced fonts give the best results 
because they ensure alignment of columns in the 
generated lists. Fonts such as Courier also work well, 
although they contain a few off-size characters.

Size Choose a font point size for cut list or change list 
displays and printing.

If you select a size that is too large, some text might 
be lost on the right side of the page when you print 
the list.

Counter Starts At Enter the footage count at which you want to cut list 
to start.

List Summary Generates a summary of all the cut lists.

Separate List for 
Each Channel

Generates a separate set of lists for each selected 
picture track. Multitrack (multilayer) effects are 
ignored and replaced with the foreground track from 
the effect. Single-track effects are treated as usual. 

When this option is not selected, the Cut List tool 
generates one set of lists for all selected picture tracks 
combined. This is the normal mode of operation.

This option affects how the track selectors behave on 
the Cut List tool.

Frame Images Displays a thumbnail frame image for each clip in the 
cut list or change list. (The frame image may be 
printed.) FilmScribe displays the starting frame from 
each event in the sequence.

Table 3-1 Cut List Global Options (Continued)

Option Suboption Description
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Icons Includes representative icons in your assemble list to 
identify each A/B-roll fade-in, fade-out, dissolve, 
dupe, jump cut, short cut, and freeze frame in the 
sequence (not applicable to single-strand A-roll or 
work print). These icons reference only 
standard-length dissolves; therefore, a 7-frame 
dissolve is referenced as an optical in the cut list, not 
as a dissolve. Note that icons used in change lists are 
different; they reference each deletion, trim, or 
insertion required to update the work print. For more 
information about icons in lists, see “Understanding 
the Cut List and Change List Tools” on page 35.

Show Prefix Identifies cuts in the cut list or change list by 
displaying the entire first and last key number for 
each cut. The generic prefix includes the code at the 
start of each key number, as in KN 12 3400. Deselect 
this option to include the entire key number for the 
first frame of each cut but only the footage and frame 
count for the last frame of each cut, minus the KN 
prefix.

Matchback Info Available only for NTSC. Shows what modifications 
were made during the matchback process. To use this 
option, you must have selected matchback at the 
project level. This option does not control whether 
matchback is performed. You determine whether 
matchback is performed when you create the project.

Disable Perf Slip Instructs the Cut List tool to ignore audio perf 
slipping and offset data when displaying ink 
numbers.

Ignore Color Effects Instructs the Cut List tool to generate the cut list 
without color effect information.

Ignore All Special 
Characters from 
Display

Instructs the Cut List tool to generate the cut list 
without graphic icons, header images, or QuickTime 
movie images.

Table 3-1 Cut List Global Options (Continued)

Option Suboption Description
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n The TAnimation, TColumnar, TOptical Block, and TStoryboard templates are 
available with a 16:9 option, allowing you to display the generated list in a 
16:9 aspect ratio.

Cut List Options That Are Common to All Lists

When you click one of the list types in the Cut List tool, the Options 
pane shows the options for that list type. 

Most options are the same for all the list types; these “common” 
options appear at the top of the display. Options that are specific to the 
selected list type appear at the bottom of the display.

Common
options

List-specific
options
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n FilmScribe can reference and include in lists only information that has been 
logged into bins using an Avid editing system or Avid MediaLog. Make sure 
to enter any information that you will need before you attempt to generate 
lists in FilmScribe.

Table 3-2 describes the common options.

Table 3-2 Cut List Common Options

Option Description

Key Numbers Displays film reference numbers based on data from the KN Start and KN End 
columns in the bin.

Ink Numbers
Aux. Ink 
Lab Roll 
Camera Roll 
Sound Roll 
Reel
Slate 
Scene/Take 

Usually apply to work prints and sound track editing. Displays user-definable 
numbers from corresponding columns in the bin. If there is no corresponding 
bin column, it means you did not log this data when you digitized; the system 
can display only information that you logged for the project. 

Clip Name Name of the master source clips used in your sequence.

Comments Includes comments about cuts or transition effects that you added to the 
sequence by using the Add Comments menu command in your Avid editing 
system. For information on adding comments, see the user’s guide to your 
Avid editing system.

Locators References sequence locators in the cut list or change list. Locators are markers 
applied to particular frames during an edit session to indicate special attributes 
such as music cues, sound effects, clap markers, and so on. If the editor’s 
locators contain comments, they are also displayed in the cut list when you 
select this option.

Custom Column from 
Bin

To add data from a custom column on a per cut basis, specify the custom 
column name. The name must be identical (including case) to the name as it 
appears in the bin.
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Cut List Options That Are List Specific

Options that are specific to a particular list appear at the bottom of the 
Options pane. The following sections explain the list-specific options 
for each type of list available in the Cut List tool.

Assemble List

Table 3-3 describes options specific to the assemble lists. 

Timecode options These options display Source timecode (based on the timecode logged in 
columns in the bin).

Record TC: Timecode that the editing system generates for a particular sequence
Start: The start timecode
Film TC: Film timecode generated during the telecine transfer
Sound TC: Address-track timecode
Aux. TC 1 – Aux. TC 5: Custom or duplicated timecode
24 TC: For 24p and 25p projects
25P TC: For 24p and 25p projects
25 TC: For 24p and 25p projects
30 TC: For 24p and 25p projects

Table 3-2 Cut List Common Options (Continued)

Option Description
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Optical List

Table 3-4 describes options specific to optical lists.

Table 3-3 Assemble List Options

Option Description

LFOA (Last Frame of 
Action)

Determines the duration of a sequence at the last 
frame that is part of the sequence, minus the length 
of the head and/or tail. Select the option and enter 
the length of the head and/or tail.

Mark Short Cuts Searches the assemble list for cuts that are shorter 
than a user-specified minimum. All such cuts are 
flagged with a comment.

Mark Jump Cuts Searches the assemble list for jump cuts that are 
shorter than a user-specified minimum. All such 
cuts are flagged with a comment. A jump cut 
occurs when a short piece of material is “missing” 
between adjacent cuts from the same source 
material.

Show Trans. FX Shows transition effects, such as dissolves, as 
comments in the assemble list rather than as 
opticals.
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Dupe List

Table 3-5 describes options specific to dupe lists.

Table 3-4 Optical List Options

Option Description

Key Frames Controls whether or not optical keyframes from 
the sequence are shown in the optical list. This 
option also displays information for Paint and 
AniMatte™ effect options. 

If you change the keyframe parameters of an 
effect, the change is reflected in the change list 
only if you select this option. 

Optical Footage Shows footage relative to the beginning of each 
optical.

Page Breaks Between 
Opticals

Each optical prints on a separate page.

Table 3-5 Dupe List Options

Option Description

Assume Handles Specify the number of frames for handles during dupe 
checking. The frames are added to the beginning and 
the end of each clip before checking for overlap. (The 
handles are not reflected in a list but are used for 
internal calculations.)
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Pull and Scene Assemble Lists

Table 3-6 describes options specific to pull and to scene assemble lists.

Print w/Handles Specify the number of frames for handles after dupe 
checking. The frames are added and displayed at the 
beginning and end of each clip in the list.

Table 3-5 Dupe List Options (Continued)

Option Description

Table 3-6 Pull and Scene Assemble List Options

Option Description

Sorting These options control how a list is sorted. They affect only 
pull lists. They do not affect assemble, optical, or change 
lists.

You can select up to three sort fields (criteria). 

First sort by Lab Roll
Camera Roll
Sound Roll
Scene/Take
Clip Name
(none)
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Change List Global Options

Like the cut list, the change list has global options that apply across the 
entire change list, affecting all other list selections. Global options on 
the Change List tool are identical to those on the Cut List tool. For 
more information, see “Cut List Global Options” on page 65.

Then sort by Same choices as First sort by

Then sort by Key Number (KN Start)
Ink Number
Auxiliary Ink
Film TC
LTC (Start)
Sound TC
Auxiliary TC 1 through TC 5

Order Heads Out (ascending edge numbers)
Tails Out (descending edge numbers)

Place Separators Controls where separators are placed in the list. The 
separator’s appearance depends on the template; usually 
it appears as a horizontal line.

First Sort Field 
Second Sort Field
Keycode or Ink Prefix
Prefix or every 1000 ft
(no separators)

Include Opticals
Include Leader

These entries specify whether to include opticals and 
leaders in the list.

Table 3-6 Pull and Scene Assemble List Options (Continued)

Option Description
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Change List Options That Are Common to All Lists

When you click a list name in the Change List tool (except for Global), 
the Options pane shows the options for the list type. Most options are 
the same for all the list types; these “common” options appear at the 
top of the display.

These options are identical to the “common” options on the Cut List 
tool. For more information, see “Cut List Options That Are Common 
to All Lists” on page 70.

Change List Options That Are List Specific

List-specific options appear at the bottom of the option display. The 
following sections explain the list-specific options for each of the list 
types available in the Change List tool.

Change List

Table 3-7 describes options specific to change lists.
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Table 3-7 Change List Options

Option Description

Show Only Changes Limits the entries in the change list to insertions, 
deletions, trims, and moves. There will be no 
explicit indication of sections that remain 
unchanged. If this option is not selected, the 
change list will also contain events that explicitly 
show sections that remain unchanged.

Combine Deletions Forces each group of adjacent deletions to be 
combined into a single event. Also, the discard list 
will be unavailable (dimmed). If this option is not 
selected, each deleted clip will have its own event 
in the change list.

Preview Code Displays preview code numbering. For more 
information on using preview code, see 
“Previewing the List” on page 47.

Counter Starts At Specify the feet + frames of the viewing footage, 
matching the footage counter on the sync block.
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Change Pull and Change Discard Lists

Options for change pull lists and change discard lists are almost the 
same as the options for the pull and scene assemble lists on the Cut 
List tool. For more information, see “Pull and Scene Assemble Lists” 
on page 75. The only difference is that the Include Leader option is not 
available for change pull and change discard lists.

Optical List

The options for optical lists on the Change List tool are the same as the 
options for optical lists on the Cut List tool. For more information, see 
“Optical List” on page 73.
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APPENDIX A

Preparing Sequences for 
FilmScribe

This appendix provides information to help you prepare your 
sequences in an Avid editing system so that FilmScribe can work with 
them successfully and you can maintain your sequences safely. It 
includes the following main sections:

• Entering Film Information

• Preparing Sequences

• Preparing QuickTime Movies

Entering Film Information

The process of working in an Avid editing system includes entering 
information associated with the clips that you digitize and the 
sequences that you build while editing. This information might be 
logged before you digitize media or added to a bin later. 

For film projects, some of this information is essential for digitizing. 
You must have information in the Start and End video timecode 
columns. For transfers to NTSC video, you must have pulldown frame 
information in the Pullin column. Other film information is not 
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essential to the basic editing workflow, but it might be necessary for 
your particular project.

Any information that you want FilmScribe to include in a generated 
cut list or change list must be entered before you work with sequences 
in FilmScribe. You cannot alter Project settings, edit bin information, or 
add new bin headings within FilmScribe itself.

For example, if you need to present information such as Scene and 
Take numbers, camera rolls, or audio timecode as part of a cut list or 
change list, you must have entered the information into the bin, either 
through the logging process or by editing the bin manually.

For procedures about supplying this information, see the user’s guide 
to your Avid editing system.

n You can open a saved list in a text editor or a word processor and then edit the 
list to add information to it. You might find this useful for adding comments 
to aid the assistant editor or negative cutter, but it is not a practical way to 
add numbering information for every clip and event in the list.

Preparing Sequences

Depending on the type of list you are creating, and the stage of your 
project, you might need to prepare the sequences before working with 
them in FilmScribe. A normal workflow for each stage of list 
generation might be as follows.
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Generating the First Cut List

To generate the first cut list for conforming a work print, follow this 
procedure in your Avid editing system:

1. Make sure the tracks you want are selected.

2. Remove any unwanted add edits (match-frame edits) by 
removing match-frame edits.

3. Duplicate the sequence and place the original sequence in an 
archive backup bin.

4. Keep the copy of your sequence in a current cuts or a 
work-in-progress bin, and generate lists in FilmScribe from the 
archived original.

For the work in progress, you can keep the file name extension 
.Copy01, created when you duplicated the sequence, as a way of 
indicating that it has been properly archived. You can also remove the 
word copy, but be sure to maintain the numbering of each successive 
cut so that you do not lose track.

Generating a Change List

As you continue working on the sequences, use the Change List tool to 
update the work print as necessary. 

To generate a change list for a conformed work print:

1. Make sure the tracks you want are selected in the new (revised) 
sequence, remove any unwanted add edits, copy the sequence, 
and place the original in the archive bin, as described in 
“Generating the First Cut List” on page 82.

2. Use successive versions of the sequence stored in the archive to 
generate the change lists. Try to maintain one sequence version for 
each time you conform the work print.
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Comparing and Combining Cuts and Reels

Often in the later stages of editing, you might need to compare several 
cuts or versions or to combine two or more reels that have already 
been conformed. Tips and techniques for preparing and managing 
multiple sequences are described in “Working with Multiple Cuts and 
Reels” on page 57.

Generating a Final Cut List

When you are ready for the final cut, you can prepare the sequences 
and generate lists and other reference elements for the negative cutter.

To generate a final cut list:

1. Make sure the tracks you want are selected, and remove any 
match frames (add edits).

2. Back up your project and bins.

3. Record a digital cut to tape, preferably with burn-in, as described 
in the Output section of the user’s guide to your Avid editing 
system.

4. Prepare assemble lists for each reel by key number.

Preparing QuickTime Movies

To take advantage of FilmScribe’s image thumbnail and movie 
playback features, you need to export your sequences from your Avid 
editing system as QuickTime movie files, and make those files 
available for FilmScribe to read them. 
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Preparing Sequences for Export

To help speed up the export and keep your data safe, consider taking 
the following steps to prepare your sequence before you export:

• Make sure all media for the sequence are online.

• Archive the sequence. Duplicate the sequence, place the duplicate 
in another bin, and prepare the duplicate for export. The original 
sequence will be unaffected.

• Render all effects. Any unrendered effects are rendered on export, 
but this can take extra time during the export process.

• Mix down multiple video or audio tracks for faster export, unless 
you need to preserve the multiple track information.

Exporting QuickTime Files

To export a sequence from an Avid editing system as a QuickTime 
movie:

1. Make the bin that contains the sequence active.

2. Select the sequence.

3. Choose Export from the File menu.

The Export As dialog box opens.

4. In the Export As dialog box:

a. Choose a location to place your QuickTime file.

b. Accept the default file name.

c. Choose Fast-Export QuickTime from the Export Setting 
pop-up menu.

d. Click Save.

The system saves your sequence as a QuickTime movie to the 
location you specified.
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n Certain characters create problems for FilmScribe when it searches for file 
names. Do not use a slash (/) or a colon (:) in the names of sequences that you 
plan to save as QuickTime movies.

n This procedure explains the simplest export process. For other export 
processes, see the documentation to your Avid editing system. 

Guidelines for File Naming

When FilmScribe generates a cut list that includes frame image 
information, it searches for the QuickTime movie by looking for a 
specific file name in a specific location.

The file name that FilmScribe searches for is the first eight characters 
of the name of the sequence itself, followed by the QuickTime file 
name extension that identifies the movie format. For example, if you 
have a sequence named “Program1,” FilmScribe will search for an 
associated movie file named “Program1.mov”.

This file name format is the one your Avid editing system uses by 
default when it saves the movie file. The simplest way to handle 
movie file names is to accept this default name when you export, so 
that FilmScribe will find it automatically when it searches.

If you want to change the file name, you can still find the file in 
FilmScribe. When FilmScribe does not find the movie file, it allows 
you to search for the movie using the Open dialog box (Windows) or 
Directory dialog box (Macintosh) to specify the file name.

n Certain characters create problems for FilmScribe when it searches for file 
names. Do not use a slash (/) or a colon (:) in the names of sequences that you 
plan to save as QuickTime movies.
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Guidelines for File Location

FilmScribe creates a folder called Sequence Movies within the 
FilmScribe folder. This is the default location that FilmScribe searches 
for movie files.

The simplest way to handle movie files is to place them in this folder 
so that FilmScribe can find them automatically. If you can navigate to 
this folder when you export the movie from your Avid editing system, 
you can save the movie to the folder directly. Alternatively, you can 
move the movie to this folder later.

If you want to keep your movie files in a different location, you can 
still find them in FilmScribe. When FilmScribe does not find the file in 
the Sequence Movies folder, it allows you to search for the movie 
using the Open dialog box (Windows) or Directory dialog box 
(Macintosh) to browse the full directory structure available on your 
computer.

When you are deciding where to locate your movie files, remember 
that their playback is affected by the time your computer takes to 
access them. Movies stored on a hard drive on the computer running 
FilmScribe will play better than movies stored on slower storage 
media or stored elsewhere on a network.
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Glossary

A-roll A method of conforming that requires the compositing of all 
multilayer effects into a single layer (including laboratory-standard 
dissolves and fades) before assembly. Also known as single-strand 
editing.

A/B-roll A method of conforming that limits the amount of optical work by 
managing most standard dissolves and fades using two strands of 
film.

aspect ratio Numerical ratio of picture height to picture width.

auxiliary ink
numbers

Additional frame identification numbers used to conform a film work 
print. FilmScribe cut lists and change lists reference auxiliary ink 
numbers. See ink numbers.

bin A specialized file in which master clips, subclips, effects, and 
sequences are organized for a project. Bins make it easier to organize 
and manipulate material for generating lists.

change list A list of instructions produced by FilmScribe that is used to track and 
compare the differences between two versions of a sequence. A change 
list is used to update a work print with specified new edits and 
revisions.
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conform To prepare a complete version of your project for viewing. The version 
produced might be an intermediate working version, or the final cut.

cut list A series of output lists containing specifications used to conform the 
film work print or negative.

dailies Film prints or video transfers of recently shot film material, prepared 
quickly so that production personnel can view and evaluate the 
previous day’s shooting before proceeding. Also referred to as rushes, 
primarily in the United Kingdom.

digital cut A copy of your project that an Avid editing system outputs directly to 
videotape.

digitize To convert analog video and audio signals to an Avid digital signal 
format.

double-strand See A/B-roll.

dupe Duplicate. A section of film source footage that has been repeated 
(duplicated) one or more times in an edited sequence. 

edgecode See edge numbers, key numbers.

edge numbers Sequential numbers mechanically printed or optically exposed along 
the edge of a strip of film to assist in matching negatives to work 
prints.

EDL Edit Decision List. A list of edits made during offline editing and used 
to conform a project in the online videotape suite. Film projects might 
require an audio-only edit decision list under certain circumstances.

fps Frames per second. A measure of the film or video display rates.

ink numbers The frame identification numbers used to conform a film work print. 
FilmScribe cut lists and change lists reference ink numbers.
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key numbers The original frame identification numbers applied by the film 
manufacturers to the film stock. Key numbers are used by the negative 
cutter to conform the film negative. FilmScribe cut lists and change 
lists reference key numbers.

locators Markers that an editor working on an Avid editing system can place in 
a sequence. The editor can associate comments with locators, and 
these comments can be reproduced in a FilmScribe list.

log To enter information about your media into bins at the beginning of 
the editing process. Logging can be done automatically or manually.

magnetic track A sound track recorded on magnetic sound recording film.

matchback Process that allows you to generate a film cut list from a 30-fps video 
project that uses film as the source material.

NTSC National Television Standards Committee. The group that established 
the color television transmission standards used in the United States. 
The NTSC standard uses 525 lines of information scanned at a rate of 
approximately 30 fps.

opticals The effects created in a film lab through a process called A-roll and 
B-roll printing. This process involves a specified manipulation of the 
film negative to create a new negative containing an effect you want. 
The most common opticals used in film editing are fades, dissolves, 
and superimpositions.

PAL Phase Alternating Line. A color television standard used in many 
countries. PAL consists of 625 lines scanned at a rate of 25 fps.

preview code Film reference numbering that applies to one generation of changes on 
the work print only.

sequence A series of clips edited together in an Avid editing system. 
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setting In FilmScribe, the name given to a saved set of options in the Cut List 
or Change List tool. By recalling a setting, you can quickly apply a full 
set of options before generating a list.

single-strand See A-roll.

template In FilmScribe, the name given to a specific text layout for a film list. 
Your choice of template governs how a list looks when you print it.

timecode A frame-accurate numbering and indexing system used for editing 
and timing film and video material. 

work print A film print made from the original negative that is used during the 
editing process to produce a cut list for final film assembly. Work 
prints are typically updated repeatedly to reflect changes in the project 
as editing proceeds.
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A
A/B-roll conforming

defined 14
Adding

comments in cut lists 12
comments to lists 51

Appearance of text in lists
changing 52

A-roll conforming
defined 14

Ascending order
in bins 34

Assemble list
described 13
options 42, 72
scene 15

Aux. Ink option (Cut List tool) 71
Avid MediaLog 11, 60

B
Bad Clip icon 24
Bins

adding information to 11
adding ink numbers to 11
adding scene information to 16

opening and closing 31
sorting items in 33
working with 31

Blend effects 17

C
Camera Roll option (Cut List tool) 71
Change discard list

described 20
options 79

Change list
common options 77
compared to cut list 10
creating across multiple reels 58
described 10
generating 82
global options 76
list-specific options 77
options 42

Change List tool
changing options 44
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opening 34
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options 75
Changing

appearance of lists 52
list options 44

Chroma key effect 17
Clip Name option (Cut List tool) 71
Clone effects 18
Closing

bins 31
Collapsing

lists 50
Combining

cuts and reels 83
Comments 12
Comparing

cuts and reels 83
Controlling

movie sequence play 53
Creating

change lists across multiple reels 58
multiple sequence cut lists 57

Cut list
adding comments in 12
common options 70
compared to change list 10
creating with multiple sequences 57
described 10
generating final 83
generating first 82
generating with matchback 64
global options 65
list-specific options 72

Cut list options
common 71
global 66
sorting 75

Cut List tool
changing options 44
closing 34
features 36
opening 34

Cut list types
assemble list 13
dupe list 18
optical list 16
optical scene pull list 22
pull list 19
scene assemble list 15
scene pull list 21

Cuts
comparing and combining 83
working with multiple 57

D
Delete Head icon 24
Delete icon 24
Delete Middle icon 24
Delete Tail icon 24
Descending order

in bins 34
Digital cut

when to use 9
Displaying

movie frames in cut list 11
Dissolve icon 24
Dissolves

laboratory-standard 15
supported in optical lists 17

Double-strand conforming
defined 14

Dragging
sequences from bins 38

Dupe checking across multiple reels 61
Dupe icon 24
Dupe list

described 18
options 42, 74
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E
Editing

16mm film 14
35mm film 14

Edits
icons for 24

EDL (edit decision list) 10
Effects

supported by optical list 16
Entering

film information 80
Expanding

lists 50
Exporting

QuickTime movies to FilmScribe 84

F
Fade In icon 24
Fade Out icon 24
Fades

laboratory-standard 15
supported in optical lists 17

File location
guidelines for movie files 86

File names
guidelines for movie files 85

Film
editing 16mm 14
editing 35mm 14
masks 18
optical lists 16
types of lists 9 to 11

Film information
entering 80

FilmScribe folder
default location for movies 86

Final cut list
generating 83

Flips and flops 18
Frame images

in lists 11
Frame reference numbers 11

G
Generating

cut list with matchback 64
lists 47

Getting sequences from bins 38
Global options 42

H
Head frames 11
Heading bars

in lists 50
Highlighting

text in lists 51

I
Icons

in lists 24
using to represent edits 24

Image thumbnails 52
Ink number list

when to use 9
Ink numbers

adding to bins 11
Ink Numbers option (Cut List tool) 71
Insert Head icon 24
Insert icon 24
Insert Tail icon 24
Interface 27
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J
Jump Cut icon 24

K
KEM roll 24
Key number list

when to use 9
Key Numbers option (Cut List tool) 71

L
Lab Roll option (Cut List tool) 71
Laboratory-standard effects 15
List headings bars 50
List options

changing 44
selecting 42

List Summary navigation 50
List Summary option 50
List window

status bar 49
working in 47

Lists
adding comments to 51
changing appearance of 52
changing fonts in 52
contexts for using 9
custom titles for 36
expanding and collapsing 50
frame images defined 11
frame reference numbers in 11
generating 47
icons in 24
previewing 47
printing 55, 57
renaming 41
saving 56

types of 8, 9, 11
understanding 35
viewing 47

Lists pane (Cut List and Change List tools) 36
Locator comments 12
Logging

film information 80
Luma key effect 17

M
Masks

film 18
Matchback 62 to 64
Matchback Info Option (Cut List tool) 69
Matte key effect 17
Media Offline icon 24
MediaLog 11, 60
Menus

described 27
general 28
window-specific 28

Movie files
file location guidelines 86
file name guidelines 85

Movie sequences
controlling play of 53
opening 53

Multiple reels
and cuts 57
combining 83
creating change lists with 58
dupe checking across 61

Multiple sequences
creating cut lists from 57
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N
Numbers

for reels 59
frame reference 11

O
Opening

bins 31
Cut List and Change List tools 34
movie sequences 53
saved lists 56
settings 45

Optical icon 24
Optical list

effects supported in 16
options 42, 73
when to use 9

Optical Media icon 24
Optical scene pull list 22
Optional lists 12

P
Paint effects 18
Picture Conforming option (Cut List tool) 66
Picture-in-Picture effect 17
Play/Pause button (Movie window) 54
Preparing

QuickTime movies for FilmScribe 83
sequences for FilmScribe 81

Preview button 36
Preview code

described 60
tracking changes with 60

Previewing
lists 47

Printing
lists 55

Pull list
described 13, 19
options 42, 75
when to use 9

Q
QuickTime movie sequences 11
QuickTime movies

exporting to FilmScribe 84
preparing for FilmScribe 83
viewing sequences in 52

Quitting
FilmScribe 26

R
Reels

comparing and combining 83
multiple, working with 57
numbers for 59

Removing
settings 46

Renaming
lists 41

S
Saved lists

opening 56
Saving

lists 55, 56
Scene assemble list

described 15
options 75
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Scene information
adding to a bin 16

Scene pull list 21
Segment effects 18
Selecting

list options 42
tracks in Cut List and Change List tools 41

Sequence Movies folder 86
Sequences

dragging from bins 38
preparing for FilmScribe 81
viewing as QuickTime movies 52

Sequences pane (Cut List and Change List tools) 
36

Settings
saving 44
using 44

Short Cut icon 24
Single-layer effects 18
Single-strand

conforming 14
Single-strand conforming

defined 14
Slider (Movie window) 54
Sorting

items in bins 33
Sorting option (Cut List tool) 75
Sound Conforming option (Cut List tool) 67
Sound Roll option (Cut List tool) 71
Standard film effects 18
Starting

FilmScribe 26
Status bar

in List window 49
Step Back button (Movie window) 54
Step Forward button (Movie window) 54
Superimposition effect in optical list 16
Switching

sort order in bins 34

T
Template option (Cut List tool) 66
Text

changing in lists 52
highlighting in lists 51

Thumbnail images 11
Title effect 17
Title text box (Cut List and Change List tools) 

36, 41
Tracking

changes with preview code 60
Tracks

selecting in Cut List and Change List tools 
41

Tracks pane (Cut List and Change List tools) 36

V
Viewing

lists 47
sequences as QuickTime movies 52

W
Windows

types in FilmScribe 29
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